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What is R?

A free software environment
(and language) for statistical
computing and graphics

© @ ® RConsole

R version 4.2.1 (2022-@6-23) -- "Funny-Looking Kid"
Copyright (C) 2822 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.® (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.

Type 'license()' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.

Type 'contributers()' for more information and

"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or

"help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

[R.app GUI 1.79 (8095) x86_64-apple-darwinl?.@]

> |

Ordination of fuzzy clusters (PCoA)
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Why is R useful?

Open source
Data management and manipulation

Importing data in various formats (like
text files, excel files, etc.)

Manipulating data (subsetting and
filtering tables, merging, transposing,
etc.)

Cutting-edge graphical data visualization

Support for rich statistical simulation and
modeling

Well established system of packages and
documentation

Active development and dedicated
community



Why is R useful?

* Open source

* Data management and manipulation

o Importing data in various formats (like

text files, excel files, etc.) ‘ Stay tuned for our
. : . lab session!
© Manipulating data (subsetting and

filtering tables, merging, transposing,
etc.)

- Cutting-edge graphical data visualization David Barnett

(Wednesday)
* Support for rich statistical simulation and
modeling Rachel Steward
(Tuesday)

* Well established system of packages and
documentation

* Active development and dedicated
community



Why R and not Excel?
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Scenario 1: Data changed
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Scenario 2: Analysis changed
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Scenario 3: Many plots needed
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Why R and not Excel?
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Scenario 1: Data changed
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Why R and not Excel?

Scenario 2: Analysis changed
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Why R and not Excel?

Scenario 3: Many plots needed
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Why R and not Excel?

Scenario 4. Someone wants to understand or repeat the
analysis

»
forthofinder/
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Why R and not Excel?

Scenario 4: Someone wants to understand or repeat the -
analysis

Reproducibility

»

Me in 2 months Me in 2 years Collaborator Paper reader
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Why R and not Excel?

Automation
Many plots in one loop
Easily repeated if the data changes

Reproducibility and transparency
You will know later what you did with the data
Other people will know what you did with the data
You can publish your code with your paper

Excel tends to change some numbers to dates etc.

wi 10.23333:1007.22

psbolcr 12.56666t/71.56

psboZcr 1&8.1I1 516.33
wit 20.73333. 1666.67

psholcr 2.34




R Studio

Integrated development environment (IDE) for R

Files Piots Packages Help

com . Export~ @ lear Al

Diamond Pricing




Help in R Studio

Press F1 when the cursor is in the name of the function

@ Rstudio
File Edit Code Vi

Plots Session Build Debug Profile Tools Help

ary of the dataset
y(plantData)

Environment is empty

# Column names of the dataset
103 coflnames(plantbata)

105 # count the number of rows in your dataset
106 nrow(plantData)

107

108 # printing whole dataset in the console (usable for small
datasets)
plantpata

row+colnames {base} R Documentation |

Row and Column Names

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions. e
Type "Ticense()” or “licence()’ for distribution details. Description

Retrieve or set the row or column names of a matrix-

R is a collaborative project with many contributors.
ike object.

Type 'contributors()’ for more information and

‘citation()” on how to cite R or R packages in publications.
Usage
Type ‘demo{)’ for some demos, "help()’ for on-Tine help, or
‘help.start()’ for an HTML browser interface to help.

Type 'q()" to quit R.

rownames(x, do.NULL = 5.7, prefix = "row”
rownames(x) <- value

>

rolnamaciy  da U0 = - ppafiv = "ral”
ST T

The help
will open
here



Where to write the code?

Console? Not good for reproducibility.

® Rstudio - [m] X
File Edit Code WView Plots Session Build Debug Profile Tools Help

# Summary O the dataset
summary (plantData)

# What type of data do I have? Environment is empty

class(plantData)

# Column names of the dataset
cofl names (plantpata)

# count the number of rows in your dataset
nrow(plantpata)

# Printing whole dataset in the console (usable for small
datasets)
plantpata

row+colnames {base} R Documentation

Row and Column Names

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license(}" or 'licence()' for distribution details.

Description

Retrieve or set the row or column names of a matrix-

R is a collaborative project with many contributors. v
like object.

"contributors() ' for more information and
ation()" on how to cite R or R packages in publications.

Console

Usage

Type 'demo(}’ for some demos, 'help()" for on-line help, or
"help.start()" for an HTML browser interface to help.

o rownames(x, do.lULL =~ °, prefix = "row
Type 'q()’ to quit R.

rownames (x) <- wvalue

>

Sv = "eal”

nrafi
R

colnameciv  dAn Wi = o -
S




Where to write the code?

Console? Not good for reproducibility.

.RStud\o
File Edit Code WView Plots Session Build Debug Profile Tools Help

-4 & - = @& (& Gotofieuncton | | - addins -

@ | @KitonSave U & | Sgnp - - % - B mun - |
Source  Visual = Outline
Yo # summary of the dataset
97 summary{plantData)
98
99 # what type of data do I have?
100 class(plantData)
101
102 # column names of the dataset
102  coflnames (plantpata)
104
105 # count the number of rows in your dataset
106 nrow(plantpata)

- R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license(}" or 'licence()' for distribution details.

R is a collaborative project with many contributors.
"contributors() ' for more information and

COnSOIe ation()" on how to cite R or R packages in publications.

Type 'demo(}’ for some demos, 'help()" for on-line help, or
"help.start()" for an HTML browser interface to help.

Type 'q()’ to quit R.

>

# v3md 2} Evomics 2024 R solution goplotmd -~ 2} RNAseq main - growth analysis ZRmd 3 — [

107
108 # printing whole dataset in the console (usable for small
datasets)
109 plantpata
1033 & Chunk & check your data - R Markdown ©
Console  Terminal Background Jobs =
© R421. -7 re

13 Project: {None) ~

Environment  History  Connections  Tutorial =[]
& B Eompot- (©@157ME- € =us- [C-
R - | M Global Emironment - a

Environment is empty

Files Plots Packages Help Viewer Presentatior — [T
s alA [ e
R: Row and Column Names « | Find in Topic |

row+colnames {base} R Documentation

Row and Column Names
Description

Retrieve or set the row or column names of a matrix-
like object.

Usage

rownames (X, do. = » prefix = "row’

rownames(x) ¢ value

rolnamec /v dn = nrafiv = "cal”



Where to write the code?
R Script / R Markdown

® Rstudio - [m] X
File Edit Code WView Plots Session Build Debug Profile Tools Help

# Summary O the dataset
summary (plantData)

Environment is empty

# What type of data do I have?
class(plantData)

# Column names of the dataset
cofl names (plantpata)

Source

# count the number of rows in your dataset
nrow(plantpata)

# Printing whole dataset in the console (usable for small
datasets)
109 plantpata

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license(}" or 'licence()' for distribution details.

S
R Rowand Column Names - [Fdiifep

row+colnames {base} R Documentation l

Row and Column Names

Description

Retrieve or set the row or column names of a matrix-
like object.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()’ on how to cite R or R packages in publications.

Usage

Type 'demo(}’ for some demos, 'help()" for on-line help, or
"help.start()" for an HTML browser interface to help.
Type 'q()’ to quit R.

rownames(x, do.lULL =~ °, prefix = "row

rownames (x) <- wvalue

>

© 5 nrafiv = "cal"
R

rolnamecfv  dn W00 =
S




Where to write the code?
R Script: Code + # Comments

=) Evomics_2025_R_ggplotrmd -~ "=l Evomics_2025_R_ggplot_solution.m 3 e [

66

67

68 ## 1. List of genes (AGI codes; there can be multiple genes per line separated by
e.g. "™

69

70 # data (gene numbers)

71 genes.pred <- read.csvZ{"data/Konecnaz021_NatCom_supplementary_data_7_for_R.csv",

72 stringsAsFactors = F)

73

74 genes <- genes.pred['duplicated({genes.pred$In), 1:2]

75 colnames(genes)[c(1l, 2}] =- c("al.ids", "ids™)

76 head(genes)

I

78 # new orthologs from thaliana (according to Brassicaceae_orthology_0)

79 ortho <- read.table(file = "data/a_lyrata_Rawat__ wv__ A _thaliana.tsv"”, header = T,
sep = "\t")

80 head(ortho)

81 1ds <- sapply(X = genes$al.ids, FUN = gene.properties, table = ortho[, 2], feature
= ortho[, 3], split =", ", USE.NAMES = F)}

82 cbhind(genestal.ids, genes%$ids, ids, genes$ids == ids)

83 ortho[grep(pattern = "ALEBG36200", x = orthofa_lyrata_Rawat), ]

84 ortho[grep(pattern = "AL6G29060", x = orthofa_lyrata_rawat), ]

85 # Notes: some orthologs are missing. Most (except of 2) are the same.

86 # I will use the old homologs for now.



Where to write the code?
R Markdown: Formatted text +  Code chunks

ie 2.Rmd R Annotations serpentine candidatesR -~ "=} Evomics 2025_R_ggplotrm 3 — [

Za

260 After that, we will remove plants that have died during the experiment. These
plants have *nA* values in columns “size_mm2” and "0Y¥_max . The NPQ values were
not measured for all plants, and we are not going to plot those columns yet, so it
is fine for now that there are some *NA* wvalues there.

261

262 . " {r Clean your data} = S A

263 # Remove all NA values from size_mm2 & QY_max column, as this indicates that
plants died during the experiment and we do not have data for them

264 pbD_clean =- plantData %=%

265 filter(!is.na(size_mm2), !is.na(Qy_max))

266« "7

267

268

269 #*Exercise 3:** Ccheck how many lines we have removed.

270 [ ]

271 Hint: use the "nrow()  function or “dim()" function on the original “plantbata’
data.frame and on the new “pD_clean” data.frame.

272

273+ "7 7{r solution dimensions, class.source= 'fold-hide', eval=FALSE} - B A

274 # Dimensions of the original data.frame (number of rows and number of columns)

275 dim(plantData)
276 £ mimen<sdinns of the ~rlearned Aa+a Frame



4.3 Modify your graph aesthetics

We will now make our box plot a bit fancier. Although the defaults often work well, you can

R I\/I ar k d OW n modify almost everything within the ggplot2 package

Here you can see how to modify various things in the plot

Can be e el e, e e, 10100
“knitted” to ’
produce report
In html, pdf,
docx etc.
| I

pl_fancy <- ggplot(pD_clean_wt, aes(x=condition_info, y=0Y _max)) +
geom_boxplot() +

geom point() +




rmarkdown : : CHEATSHEET

What is rmarkdown?

.Rmd files - Develop your code and
ideas side-by-side in a single
document. Run code as individual
chunks or as an entire document.

Dynamic Documents - Knit together
plots, tables, and results with
narrative text. Render to a variety of
formats like HTML, PDF, MS Word, or
MS Powerpoint.

L

e
=
=8
O

Reproducible Research - Upload, link
to, or attach your report to share.
Anyone can read or run your code to
reproduce your work.

Workflow
€ Open anew Rmdfile in the Rstudio IDE by
going to File > New File > R Markdown.
o Embed code in chunks. Run code by line, by

chunk, or all at once.

Write text and add tables, figures, images, and
citations. Format with Markdown syntax or the
RStudio Visual Markdown Editor.

Set output format(s) and options in the YAML
header. Customize themes or add parameters
to execute or add interactivity with Shiny.

e Save and render the whole document. Kni
periodically to preview your work as you write.

Share your work!

SOURCE EDITOR

autput
henl_docunant

run code ™
chunk(s) show
outline

unent Title set
preview
location

insert
code
chunk

goto
code
chunl

hor Nane!

e 4. Set Output Format(s)
and Options

opts_chunksset echo

13- ¥¢ R Markdown
14

15 This §s an R Markdown document.
16 Markdown is a simple formatting
17 syntax for authoring HTML, PDF,
18 and NS Word documents.

:

20- (e
[er——

3. Write Text

runall
previous

modify chunks

chunk

options

run
current
chunk

21 summary cars
2

DI

Output created: report.htm

dd/edit
VISUAL EDITOR Stutes

R Markdown
tyle options  insert citations
This is an R Markdown document. Markdown s a simple formarting syntax for

authoring HTML, PDF, and MS Word documents.

Embed Code with knitr

CODE CHUNKS

Surround code chunks with ** &) and """ oruse
Add a chunk label
and/or chunk options inside the curly braces after r.

the Insert Code Chunk button.

"**{r chunk-label, include=FALSE}
summary (mtcars)

SET GLOBAL OPTIONS

Set options for the entire document in the first chunk.

"' {r include=FALSE}
knitr::opts_chunk$set(message =

INLINE CODE

Insert r <code>" into text sections. Code is evaluated

at render and results appear as text.

“Builtwith *r getRversion() '*->"Built

== posit

FALSE)

ith4.1.

OPTION
echo

DEFAULT EFFECTS
TRUE  display code in output document

TRUE (display error messages in doc)
FALSE (stop render when error occurs)
run code in chunk
include chunkin doc after running
display code messages in document
display code warnings in document
"asis" (passthrough results)
"hide" (don't display results)
"hold" (put all results below all code)

“left", "right", or "center”

alt text for a figure

figure caption as a character string
prefix for generating figure file paths

error
eval
include
message
warning

results

fig.align
fig.alt
fig.cap
fig.path
fig.width &
fig.height 7
out.width
collapse
comment

"default”
NULL
NULL

“figure/"

plot dimensions in inches

rescales output width, e.g. "75%", "300px™
collapse all sources & output into a single block
prefix for each line of results

files(s) to knit and then include

«child NULL
include or exclude a code chunk when
purl TRUE  axtracting source code with knitr::purl()

See more options and defaults by running str(knitr::opts_chunk$get())

FALSE
g

CCBY SAPosit Software, PBC « info@posit.co « posit.co « Lea more at

@ reporthtml

RENDERED OUTPUT

file path to output document
“Desktapirapieipart Nomi

Open In Browser 4 Publish ~

findin document
publish to
rpubs.com,
shinyapps.io,
Posit Connect

Document Title

Author Name

* R Markd
* Including Plots

R Markdown

This is an R Markdown document, Markdown is a simple formatting
syntax for authoring HTML, PDF, and MS Word documents. For more
details on using R Markdown see http://t m

reload document

wn.rstudio

summary(cars)

»
#
#
#
i
#
#

® weosremi a5, 222,711

Insert Citations

Create citations from a bibliography file, a Zotero library,
or from DO references.
BUILD YOUR BIBLIOGRAPHY

Add BibTeX or CSL bibliographies to the YAML header.

title: "My Document"

bibliography: references.bib
link-citations: TRUE

If Zotero is installed locally, your main library will
automatically be available.

Add citations by DOI by searching "from DOI" in the
Insert Citation dialog.

INSERT CITATIONS

« Access the Insert Citations dialog in the Visual Editor
by clicking the @ symbol in the toolbar or by clicking
Insert > Citation.

« Add citations with markdown syntax by typing [@cite]
or @cite.

Insert Tables

Output data frames as tables using

kable(data, caption). ‘oo .....,i

A

data <- faithful[l:4, ]

knitr::kable(data,
caption = "Table with kable")

Other table packages include flextable, gt, and kableExtra.

rstudio.com - HTML c!

Write with
Markdown

The syntax on the left renders as the output on the right.

Plain text.
End a line with two spaces to
start a new paragraph.

Also end with a backslash\
tomake a new line.

“italics” and **bold**
superscriptA2A fsubscript~2~
~~strikethrough=~
escaped:\"\_\\

endash: ==, emdash: ===
#Header 1

44 Header 2

#4844 Header 6
-unordered list
-item2

- item 2a (indent 1 tab)
-item 2b

1. ordered list

2.item2
- item 2a (indent 1 tab)
-item 2b

<link uri>
[This is a link J(link url)
[This is another link][id].
At the end of the document:
[id]: link url
![Caption](image.png)
or l[Caption][id2]

At the end of the document:
[id2]:image.png
“verbatim code’
multiple lines
of verbatim code

> block quotes

equation: $eAi\pi} + 120§

‘equation block:
$SE=mch2}$$

horizontal rule:

| Ri |
| { 1

112]112]12| 12|

1123123 123]123]

1

L Tabsets
## Results [ tabset}
444 Plots

tet

#5# Tables

mare text

Plain text.

End a line with two spaces to
start a new paragraph.

Also end with a backslash
to make a new line.

italics and bold
superscript?/subscriptz

escaped: * _\
endash: -, emdash: —

Header 1
Header 2

Header 6
« unordered list
item2

- item Z;(ir\dent 1tab)

- item 2|

1. ordered list

2. item2

« item 2a (indent 1 tab)
b

« item 2

http://www.posit.co/
This is a link
This s another link

Caption.
verbatim code

multiple lines
of verbatim code

block quotes
equation: ¢ + 1 =0
equation block:
E=mc?

horizontal rule:

Default  Center

2.23 - Updated: 2023-07




General data structures

Vector - ordered collection of data
vector_ 1 <- c(2, 3, 4, 10)
vector_2 <- c(“potato”, “lemonade”, “avocado”)

Matrix - 2D collection of vectors with same data type
Array - multiple dimension collection of vectors

Dataframe - matrix-like with multiple data types (like an excel table
with text and numbers)

Lists - ordered collection of any objects (can contain also other lists
inside it)

Vector

117

Data Frame

http://venus.ifca.unican.es/Rintro/dataStruct.html



But...

which dataset should we use to try R?



Arabidopsis thaliana mutants
psbol and psbo2




PsbO protein

« Subunit of photosystem II
« Important for water splitting
 Arabidopsis: PsbO1 and PsbO2

STROMA

PsbO  PsbQ

LUMEN

Photosystem ||



PsbO protein

« Subunit of photosystem II
« Important for water splitting
 Arabidopsis: PsbO1 and PsbO2

STROMA

Photosystem ||



Experimental design

Control Drought Salt stress

- water + NaCl



Measurement — chlorophyl
fluorescence

* Leaf rosette area
* F,/Fy (QY_max) — maximum quantum yield of photosystem Il

WT psbol psho?2

Images from FluorCam (PSI) device



Let‘s start the practical!

Open the Rstudio server by typing in browser:
<your IP>:8787

SR\ S

Remember:
« Practise makes the masters.
« Do sanity checks. Always.

« Use Al, but try to understand, check and improve
the code.
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